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Part A  

S.No Units 
Duration in 

Periods 

Marks  

1.  Unit 1: Communication Skills – II  13 
 
 
 
 
 
 

10 

2.  Unit 2: Self-management Skills – II 07 

3.  Unit 3: Basic ICT Skills- II 13 

4.  Unit 4: Entrepreneurial Skills – II 10 

5.  Unit 5: Green Skills – II 07 

Total 50 

 
 
  



4  CURRICULUM (X) 2019-20 

 

 

Unit 1: Communication Skills – II 

Learning Outcome Theory (7 Periods ) Practical (5 Periods) 
Total Duration 
(12 Periods) 

1. Demonstrate 

knowledge of 

various methods 

of communication 

  

1. Methods of 

communication 

A. Verbal 

B. Non-verbal 

C. Visual 

1. Writing pros and 

cons of written, 

verbal and non-

verbal 

communication 

2. Listing do’s and 

don’ts for avoiding 

common body 

language mistakes 

2 

2. Provide 

descriptive and 

specific feedback   

1. Communication 

cycle and 

importance of 

feedback 

2. Meaning and 

importance of 

feedback 

3. Descriptive 

feedback - written 

comments or 

conversations 

4. Specific and non- 

specific feedback 

1. Constructing 

sentences for 

providing 

descriptive and 

specific feedback 

2 

3. Apply measures 

to overcome 

barriers in 

communication 

  

1. Barriers to 

effective 

communication – 

types and factors 

2. Measures to 

overcome 

barriers in 

effective 

communication 

1. Enlisting barriers 

to effective 

communication 

2. Applying 

measures to 

overcome barriers 

in communication 

2 

4. Apply principles of 

communication 

  

 

 

 

 

 

 

1. Principles of 

effective 

communication 

2. Cs of effective 

communication 

1. Constructing 

sentences that 

convey all facts 

required by the 

receiver 

2. Expressing in a 

manner that shows 

respect to the 

receiver of the 

2 
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message 

3. Exercises and 

games on applying 

7Cs of 

effective 

communication 

5. Demonstrate 

basic writing skills 

  

1. Writing skills to 

the following: 

 Sentence 

 Phrase 

 Kinds of 

Sentences 

 Parts of 

Sentence 

 Parts of Speech 

 Articles 

 Construction of a 

Paragraph 

1. Demonstration 

and practice of 

writing sentences 

and paragraphs 

on topics related 

to the subject 
5  

Total 13 
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Unit 2: Self-management Skills – II 

Learning Outcome Theory         Practical         
Total Duration 

 Periods 

1. Apply stress 

management 

techniques 

  

1. Meaning and 

importance of 

stress 

management 

2. Stress 

management 

techniques – 

physical 

exercise, yoga, 

meditation 

3. Enjoying, going 

to vacations and 

holidays with 

family and 

friends 

4. Taking nature 

walks 

1. Exercises on stress 

management 

techniques – yoga, 

meditation, physical 

exercises 

2. Preparing a write-up 

on an essay on 

experiences during a 

holiday trip 4 

2. Demonstrate the 

ability to work 

independently 

1. Importance of 

the ability to 

work 

independently 

2.  Describe the 

types of self-

awareness 

3.  Describe the 

meaning of self- 

motivation and 

self- regulation 

1. Demonstration on 

working 

independently goals 

2. Planning of an activity 

3. Executing tasks in a 

specific period, with 

no help or directives 

4. Demonstration on the 

qualities required for 

Working 

independently 

3 

Total 7 
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Unit 3: Information and Communication Technology Skills– II 

Learning Outcome Theory (       Period) Practical (        Period) 
Total Duration 
(13 Periods) 

1. Distinguish between 

different operating 

systems 

1. Classes of 

operating systems 

2. Menu, icons and 

task bar on the 

desktop 

3. File concept, file 

operations, file 

organization, 

directory structures, 

and file- system 

structures 

4. Creating and 

managing files and 

folders 

1. Identification of task 

bar, icons, menu, etc. 

2. Demonstration and 

practicing of creating, 

renaming and deleting 

files and folders, 

saving files in folders 

and sub- folders, 

restoring files and 

folders from recycle 

bin 

6 

2. Apply basic skills for 

care and maintenance 

of computer 

1. Importance and 

need of care and 

maintenance of 

computer 

 Cleaning 

computer 

components 

 Preparing 

maintenance 

schedule 

 Protecting 

computer against 

viruses 

 Scanning and 

cleaning viruses 

and removing 

SPAM files, 

temporary 

 files and folders 

1. Demonstration of the 

procedures to be 

followed for cleaning, 

care and maintenance 

of hardware and 

software 

7 

Total 13 
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Unit 4: Entrepreneurial Skills – II 

Learning Outcome Theory (      Periods) Practical (   Periods) 
Total Duration 
(10 Periods) 

1. List the characteristics 

of successful 

entrepreneur 

1. Entrepreneurship 

and society 

2. Qualities and 

functions of an 

entrepreneur 

3. Role and 

importance of an 

entrepreneur 

4. Myth about 

entrepreneurship  

5. Entrepreneurship 

as a career option 

1. Writing a note on 

entrepreneurship as 

career option 

2. Collecting success 

stories of first 

generation and local 

entrepreneurs 

3. Listing the 

entrepreneurial 

qualities analysis of 

strength and 

weaknesses 

4. Group discussion of 

self- qualities that 

students feel are 

needed to become 

successful 

entrepreneur 

5. Collect information 

and related data for a 

business 

6. Make a plan in team 

for setting up a 

business 

 10 

Total 10 

 

  



9  CURRICULUM (X) 2019-20 

 

 

Unit 5: Green Skills – II 

Learning Outcome Theory (      Periods) Practical (       Periods) 
Total Duration 
(08 Periods) 

1. Demonstrate the 

knowledge of 

importance, problems 

and solutions related 

to sustainable 

development 

1. Definition of 

sustainable 

development 

2. Importance of 

sustainable 

development 

3. Problems related 

to sustainable 

development 

1. Identify the problem 

related to sustainable 

development in the 

community 

2. Group discussion on 

the importance of 

respecting and 

conserving indigenous 

knowledge and 

cultural heritage 

3. Discussion on the 

responsibilities and 

benefits of 

environmental 

citizenship, including 

the conservation and 

protection of 

environmental values 

4. Preparing models on 

rain water harvesting, 

drip / sprinkler 

irrigation, vermin 

compost, solar energy, 

solar cooker etc. 

7 

Total 7 

 



 

 

                                         Communication skills 

What is communication? 

The imparting or exchanging of information by speaking,writing or 

using some other medium and means of sending or receiving 

information. 

                                    

    *The following figure represents types of communication 

                                      (Fig 1) 

         Learning objectives of Effective communication 

1. Development of Interpersonal Skills 

2. To express effectively & with maximum efficiency 

What is Writing? 

Writing is a form of communication that allows students to put their 

feelings and ideas on paper, to organize their knowledge and beliefs into 



 

 

convincing arguments, and to convey meaning through well-constructed 

text. In its most advanced form, written expression can be as vivid as a work 

of art.                                   

                                      Grade 10 

1.Phrases- Phrases are a group of words that work together to communicate 

an element of speech. 

The following figure represents the differet types of phrases 

                                                            Fig 2 

                              

 

 

The following link further explains use of phrases in communicating better and 

with much ease. 

https://youtu.be/YbLUN_1YX2k 

Activity 1 ( Writing skills) 

The following activity may help the students to strengthen the concept further: 

  Description 

 Write phrases on both sides of the card or the paper. Show them only one side 

and ask them to guess the back side. 

*To further build up the concept, few worksheets will be given to check how 

much they have learnt . One of the example is listed below 



 

 

                                                        
Identify the phrase type: 
 

1..Houses are [unbelievably expensive] 
just now. 

Adjective Phrase 
 Adverb Phrase 
 Noun Phrase 
 Prepositonal Phrase 
 Verb Phrase 

2. We [met Paul] last week Adjective Phrase 
 Adverb Phrase 
 Noun Phrase 
 Prepositonal Phrase 
 Verb Phrase 

3. 3. [A car that won't go] is not particularly 
useful 

Adjective Phrase 
 Adverb Phrase 
 Noun Phrase 
 Prepositonal Phrase 
 Verb Phrase 

4.. I enjoy eating [in Indian restaurants] Adjective Phrase 
 Adverb Phrase 
 Noun Phrase 
 Prepositonal Phrase 
 Verb Phrase 

5. . Don't you have to leave [early]? Adjective Phrase 
 Adverb Phrase 
 Noun Phrase 
 Prepositonal Phrase 
 Verb Phrase 

 6. Tell [him] not to worry. Adjective Phrase 
 Adverb Phrase 
 Noun Phrase 
 Prepositonal Phrase 
 Verb Phrase 

 

 2.Kinds of sentences 

        What is a sentence?  

A set of words that is complete in itself, typically containing a subject and 

predicate, conveying a statement, question, exclamation, or command, and 

consisting of a main clause and sometimes one or more subordinate clauses. 

 

             



 

 

 

The above figure represents 4 types of sentences 

The following link will further help to build up the concept) 

(https://www.youtube.com/watch?v=IuDSRs_lZBk) 

 Activity 2 

Whole-Group Game: Four Corners 

Instructions 

1. Hang the sentence banners in each corner of the classroom. 

2. Students choose a corner in which to stand. 

3. Teacher reads a sentence. 

4. If students think it is the sentence type designated by their corner, they sit 

down. 

5. If students are wrong (they stand up in the wrong corner/don’t stand up in 

the correct corner), they are out of the game! 

6. Students who are correct get a punctuation badge (sticker). 

7. Teacher reads 10 sentences. The student with the most stickers is the 

Sentence Champ! 

                                         

 



 

 

 
Name: ________________________ Date: ______________ 
Identifying Four Kinds of Sentences Worksheet 

Directions: Read each sentence and add the correct punctuation mark. Then, label 
it; imperative, declarative, interrogative or exclamatory. 
 
  How well she sings! 
 
2. What is your name? 
 
3. Did I say anything to make you angry? 
 
4. What is your name? 
 
5. Who told you this? 
 
6. She is a successful writer. 
 
7. It is raining cats and dogs. 
 
8. I want to become a writer. 
 
9. She does not eat meat or fish. 
 
10. Go at once. 
 
11. Bring me that file. 
 
12. My mother makes delicious cookies. 3. Get lost. 
 
14. Fetch me a glass of water. 
 
15. Please be seated. 
 
16. Sit down. 

There are four kinds of sentences in the English language. 
1. Imperative- gives a command (.) 
2. Declarative- makes a statement (.) 
3. Interrogative- asks a question (?) 
4. Exclamatory- expresses strong feeling (!) 



 

 

 
17. She writes with her left hand. 
 
18. What a tragedy! 
 
19. How beautiful she is! 
 
20. I have two sisters. 
 
21. How ridiculous this is! 
 
22. I have lost my way. 
 
 
 

3. Parts of speech-  A category to which a word is assigned in accordance with 

its syntactic functions. In English the main parts of speech are noun, pronoun, 

adjective, determiner, verb, adverb, preposition, conjunction, and interjection. 

The following figure represents eight parts of speech 

                                                  

 

The following link will help to reinforce the concept 

(https://www.youtube.com/watch?v=v9fCKTwytJA) 

Activity 4 

 Class projects can be an excellent way to focus the whole class and get them 

working together towards a common goal. Taking some ‘time out' from regular 



 

 

classes and doing something completely different can really help group 

dynamics and you may also give quieter or less able students a chance to 

shine. Making a class magazine is a project that will appeal to most groups as it 

allows individuals to work on what interests them. Starting a project from 

scratch can seem a little daunting to begin with so here's a simple step-by-step 

guide on how to make a class magazine.  

Planning 

*Bring in some magazines. Let the students have a look through them. The 

teacher will a class survey on magazines at this stage or simply converse  with 

the class about the type of magazines they like. 

*On the board. brainstorm the different sections that magazines have. Try to 

include as much variety as possible so there's something for everyone. 

(Horoscopes, sports pages, film reviews, cinema news, fashion, photo stories, 

comic strips, puzzles, technology pages, music, interviews with famous people, 

recipes, jokes, problem pages etc. etc.) 

Making a class magazine should be an enjoyable experience for the students  

.This will improve their writing skills and simultaneously help them to express 

and know each other better. 

 

Article writing 

Article writing is the process of creating a non-fiction text about current or 

recent news, items of general interest or specific topics. 

The following figure represents the format of Article writing 

                                              * Figure 5 



 

 

 

 The following link will help to build up the concept 

https://youtu.be/q2197KT1iNE?list=RDQMaJwsUDCsYv4 

 Activity 5 

Doing surveys can be a useful way of getting your students to interact, produce 

question forms and collect and analyse real information. 

This survey has been designed for younger learners and is based on the theme 

of school subjects. 

Preparation 

 One class is going to  survey a different class that they don't know. It’s a good 

idea to choose a group who have a higher level than your own group as this 

avoids misunderstandings in the survey. Examples of few questions which can 

be asked are listed below 

1) What’s your favourite subject? 

2) What’s your worst subject? 

3) What’s the most important school subject? 



 

 

 After a brief discussion,students will write an article highlighting the problems 

students are facing in different subjects and remedial measures on the same. 

This activity gives them the chance to practise target language in context and it 

also prepares them for the survey with students they may not know. 

 

 

 

5. Construction of the Paragraph 

     What is a paragraph? 

    A paragraph is a series of sentences that are organized and coherent, and 

are all related to a single topic. 

 

 

 

 

 



 

 

Activity – A perfect story 

This activity leads students into writing a short story using the past simple, 

present perfect simple and continuous, but in a more creative way.This activity 

aims to help students to recognise their own problems with paragraph 

construction and to identify errors, which improves their own re-drafting skills. 

 1.The students they are going to write a short story. 

 2.The students will read the following questions and decide, with a partner, 

what the missing words are, but not answer the questions . What is his / her 

name? 

a) What is __________ about them? (e.g. strange / unusual / nice...) 

b) What was their --problem last year? 

c)What happened? 

d) Why have they become so __________ ? 

e) How many __________ have they -__________ ? 

f) Who have they been __________ recently? 

g) What have they been __________ for the last five years? 

 The students, working in pairs still, have to answer the questions. The answers 

should link the questions together to form the basis of a story. Students can 

draw their characters. This is fun and brings the character to life. Students can 

laugh at each other's drawings. Using the notes above, students put the story 

together. This activity aims to help students to recognise their own problems 

with paragraph( story) construction and to identify errors, which improves 

their own re-drafting skills 

 



 

 

 

 

 

 

        

 

 

 

 



 

 

   
 
  
 

 

Summary: 

 A classroom environment relies heavily on the quality of communication 

taking place within it. As an instructor, taking steps towards improving the 

communication skills of your students will contribute positively towards your 

classroom climate. Students with effective communication skills will be more 

likely to contribute to class discussions, will be more productive members in 

group projects, and will ultimately gain more from their experience in  the 

class. Learning and practicing writing skills help students to handle professional 

and social tensions.  
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Communication Skills  - Activity  

 

Unit -1  

 Demonstrative knowledge of Various methods of Communication  

1 

 

CS 10 Worksheet 1 : Actions Speak larger than words! 

Role Plays : 

A 

Note to teacher.Before Class:  

Allot the 4 role plays to students in advance to prepare i.e before the class period. 

Ask them to exaggerate the body language.Guide and help the pairs. 

In class: 

Ask pairs to role play the situations . 

In plenary or after each role play elicitwhat is being expressed so eloquently by the body language.  

Post Each Role Play 
Ask class to describe what Student B  was thinking and feeling; what message was he/she sending. Ask for  specific “clues” based on what 

Student B did with body ,face, hands etc. 

Role Play 1[A1]:  

Student A:Tell your partner  aaallll about your family. 

   Student B You are getting bored. Tap your foot. Look around, fidget, look from side to side, avoid eye contact. 

Role Play 2  

   Student A: Tell your partner what happens in your favorite movie 

       Student B Lean forward, keep still ,be comfortable ,have eye contact, and nod. 

Role Play 3  

       Student A: Make a long list of excuses as to why you didn’t do your homework.  

        Student B You are the teacher. Put your hands on your hips, roll your eyes, shake your head, keep muscles tense, look angry.  

Role Play 4 

      Student A: Ask student if he knows who has physically assaulted a class mate/or damaged the    class furniture during interval.  

Student B Sit hunched over, look 

down, avoid eye contact, and fiddle with something-belt etc 

 

Positive Body Language                                            Negative Body Language             
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 Demonstrative knowledge of Various methods of Communication  

2 

 

Examine the table given below. 

Add to the list of body language 

behaviors! 

 

 

 

 

 

 

 

 

 

 

 

 smiling    

 eye contact, wide open    

 forward lean      

 nodding  

 positive facial 

expression                               

 fake yawn 

 stare  

 moves awayfrom speaker 

 shakes head negatively 

 negative facial expression 
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Unit -1  

 Demonstrative knowledge of Various methods of Communication  

3 

 

          

 

 

 

 

 
CS 10Worksheet 2 What’s  Your Emotional Intelligence: How well do you read other people? 

Adapted from Greater Good Magazine  Berkeley 

 
A Take the Quiz 
  

1 

 

 
 

This face is expressing... 

1. Embarrassment 

2. Fear 

3. Sadness 

4. Surprise 

 

2 

 

 

 

         

    

2. This face is expressing... 

1. Shame 

2. Anger 

3. Sadness 

4. Pain  
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4 

 

 

 

3 This face is expressing... 

1. Pride 

2. Contempt 

3. Excitement 

4. Anger 

 

 

4 

 

 

 

4 This face is expressing... 

1. Guilt 

2. Sadness 
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3. Pain 

4. Disgust 
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5 This face is expressing... 

1. Fear 

2. Interest 

3. Surprise 

4. Compassion 

 

 

6 This face is expressing... 

1. Sadness 

2. Shame 

3. Disgust 

4. Contempt 

  

 

7This face is expressing... 

1. Embarrassment 

2. Sadness 

3. Amusement 

4. Shame 
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8This face is expressing... 

 

1. Happiness 

2. Desire 

3. Politeness 

4. Compassion 

 

 

9 This face is expressing... 

1. Anger 

2. Pain 

3. Disgust 

4. Sadness 

 

10 

 

 

10 This face is expressing... 

1. Compassion 

2. Sadness 

3. Anger 

4. Interest 
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8 

 

 

 

 
11This face is expressing... 

1. Amusement 

2. Desire 

3. Surprise 

4. Excitement 

 

 

 
12This face is expressing... 

1. Surprise 

2. Interest 

3. Desire 

4. Happiness 

 

13 
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13This face is expressing... 

1. Sadness 

2. Shame 

3. Disgust 

4. Compassion 

 

 
 

14 This face is expressing... 

1. Sadness 

2. Pride 

3. Embarrassment 

4. Shame 
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10 

 

 
15This face is expressing... 

1. Flirtatiousness 

2. Interest 

3. Happiness 

4. Politeness 

 

 
16 This face is expressing... 

1. Sadness 

2. Pain 

3. Anger 

4. Disgust 
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11 

 

 
17This face is expressing... 

1. Satisfaction 

2. Flirtatiousness 

3. Love 

4. Compassion 

 

 

B Check your answers at the end of the unit. 

 Discuss your rating with your group. 

 Who has got the highest score? 

 Do you think one can become better at reading faces and 

expressions?How? 

 Choose a facial expression from the ones you examined in the quiz. 

 Mime it . 

 Ask your group to guess what you are feeling. 

Answers Quiz :Emotional Intelligence 

 
1 fear 

2 pain 

3 pride  

4 pain 

5surprise  

6contempt ? 

7embarrasment 

8 politeness 
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9 disgust 

10 compassion 

11amusement 

12interest 

13 sadness 

14 shame 

15happiness 

16anger 

17 love 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

C Look at the visuals of facial expressions below.  

 Learn  more about how we form these expressions! 

 Discuss which  expressions are desirable when you are with people.  

 Which expressions are undesirable when you are with people? 

 Choose a facial expression from the ones you examined in the quiz. 

 Mime it . 

 Ask your group to guess what you are feeling. 
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13 

 

1 Fear 

 

 

 
 

 

Answer:  Fear 

We express fear when we feel threatened. 

 our eyes open wide open 

 our jaw drops  

 and the mouth hangs open.  

2  Happiness 

 

 
 
  

 
Submit Answ er

 
Submit Answ er
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3 Embarrassment  

 

 
 

  gaze is averted 

 head moved down  to the side,  

 neck  exposed.  

4 Pride 

 

 
  

 
 
 
 
 
 
 
5 surprise 
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6 Contempt 

 

 
7 Disgust 
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16 

 

 
  

 

8 Pain 

 

Submit Answ er
 

 
9 Compassion 
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10 Amusement  
 

 
 

11 Interest 
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18 

 

 
 

 

12 Sadness 
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13 Shame  

 

 

 

 

 

 

 

14 Politeness 
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15 Pain  
Submit Answ er

[A2] 
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16 Love  

 
 

 Love 
When we feel love, our facial expression often resembles happiness:. 

. 
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CS 10 Worksheet 3  

1.Examine the information given in Figure 1. 

It shows the percentages allotted for the 3 elements of personal communication.  

The 3 elements are : 

a)spoken words 

b)body language 

c)voice and tone 

 

2Try and guess  what percentages each would have in order of importance? 

Give reasons for your answers. 

a)spoken words      ----------%-- 

b)body language     ----------%-- 

c)voice and tone     ----------%-- 

3 Check the  answer from the answers to Figure 1a and Figure 1b given at the end 

of the unit. 

4  

 

 

 

 

 
 

               Figure 1a 

[A3][A4] 
Next check whether you were correct in your estimate of allotting percentages! 
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 Figure 1b   

 
 

3 Notice how important voice and tone are in personal 

communication.  

 

a)Let us find out how to use our  voice modulation ,tone and 

word stress  by doing the following activity.  
b)In pairs take turns and speak aloud the following  

sentences.  

c)The word that is in bold must be spoken with emphasis. 

d) After each sentence discuss what you are trying to 

communicate by using that particular tone and word 

stress.The first one has been done for you. 

e)Attempt all the sentence sin turns and write down  what 

each one means. 

f) Finally  check your answers given at the end of the unit.  

 

 



 

 

Communication Skills  - Activity  

 

Unit -1  

 Demonstrative knowledge of Various methods of Communication  

24 

 

Placement of the 

emphasis 
What it means 

I did not tell John you 

were late. 

Someone else told John you were 

late. 

I did not tell John you 

were late. 
This did not happen. 

I did not tell John you 

were late. 
I may have implied it. 

I did not tell John you 

were late. 

But maybe I told Sharon and 

José. 

I did not tell I was talking about someone 
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Placement of the 

emphasis 
What it means 

John you were late. else. 

I did not tell John 

you were late. 
I told him you still are late. 

I did not tell John you 

were late. 

I told him you were attending 

another meeting. 

Changing your tone can dramatically change your meaning. 

Source: Based on ideas in Kiely, M. (1993, October). When 

“no” means “yes.”  

 
              

 
 

 

 

Do you agree with the statement given in 3a and 3b.Discuss with your partner. 
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      Figure 3a                                                                                

 

 
                                                                                 

 

   

Figure 3b 
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4 Your friend has been selected for an interview. 

 Examine the visuals given below.  

 What does each visual  they tell you about the person?Write a few wods and phrases beow each visual. 

 Your friend is not very good with his body language.He is soon going for an interview. 

 Think of suitable advice to give to your friend . 

 Based on the visuals below write a set of 6 sentences advising your friend what not to do . 

 

 

 

 

 

                                                    Figure 4 

 

 

a)  

________________ 

 

b) [A5] 

 

 

 

c) [A6] 
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d)  

 

____________________________________ 

 

e)  

 

_____________________________________ 

 

 

 

[A7] 
\ 

 

_______________________________ 

f) 
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CS10Worksheet 4  

1 Examine the following visual. What are the Do’s and Don’ts of body language when you are appearing for an 

interview? 

Complete the sentences given below the visual. 

 

Figure 5  

. [A8] 
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Body Language :Don’t do the following: 

(i)You mustn’t__________________ 

(ii)You shouldn’t___________________ 

(iii)Don’t________________ 

(iv)Be careful about ______________________ 

(v)Don’t________________ 

(vi)______________________ 

  

 

2Look at Figure 6a 

a) Read the cues of the Do’s and Don’ts of body Language given in Figure 6a . 

b) Discuss what are the five main elements of Body Language. 

c) Using the clues given in Figure6b and the Do’s and Don’ts column,fill in the blanks using appropriate 

words.  

d) Check your answers given at the end of the unit. 

 

 

Figure 6 a 

 

s.n Element/Features of Body L Do’s Don’ts 

1 a)____contact make appropriate eye contact -  j)____away-shifty 

prolonged eye contact 

2 _b)_____ Expression 

 

f) _______facial expression _ poker/k)____ face 

3 c)_______________ keep g)____ uncrossed,using  

meaningful and appropriate 

gesture 

cross arms,l)_______ or 

exaggerate 

4 _d)_________ head up and alert,h)___ leaning 

forward  

turn your  m)____ on 

someone,arm crossing,leg 

crossing 

5 e)___________ distance  not too i)___ and not too close  make listener uncomfortable 

with your   n)_____ 

 

 

 

Figure 6b 

 

 

 

 

 

 

 

Far 

Back  
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Worksheet 5 

CS 10  Worksheet 5  

  1In Column A, fill in the 3 blanks by listing the 3 main kinds of communication. 

  2In column B list examples of each of the 3 kinds of communication. 

 3 In pairs discuss 

 How and when you use a particular kind of communication. 

 Whether these different kinds of communication occur  separately or whether  you use more than one type of 

communication simultaneously! 

   4   In column C list the advantages of each of the 3 types of communication. 

   5   In Column D list the disadvantages of each of the 3 kinds of communication.. 
s
.
n 

           A 

types of communication 

definition 

      B 

examples 

                        C 

           Advantages  

                D 

         Disadvantages 

1 ______________________  conversations 

one on one 

 ________ 

 ___________ 

 __________ 

 

    

2 _______________  letter to 

principal 

 _______ 

 ____________ 

 _________ 

 ___________ 

 

  

 

 

3   Shaking 

hands,smiling 

 Road signs 

  ____________ 

 __________ 
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ANSWERS 

 

CS10 Worksheet 3  Figure 1a 

 

 
 

Figure 1b 

 
 

 

Figure 2  
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Placement of the 

emphasis 
What it means 

I did not tell John you 

were late. 

Someone else told John you were 

late. 

I did not tell John you 

were late. 
This did not happen. 

I did not tell John you 

were late. 
I may have implied it. 

I did not tell John you 

were late. 

But maybe I told Sharon and 

José. 

I did not tell I was talking about someone 
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Placement of the 

emphasis 
What it means 

John you were late. else. 

I did not tell John 

you were late. 
I told him you still are late. 

I did not tell John you 

were late. 

I told him you were attending 

another meeting. 

 

 

 

 

Worksheet 4 Figure 6  

 

 

 

 

Figure 6 a 

 

s.n Element/Features of Body L Do’s Don’ts 

1 a)____contact make appropriate eye contact -  j)____away-shifty 

prolonged eye contact 

2 _b)_____ Expression 

 

f) _______facial expression _ poker/k)____ face 

3 c)_______________ keep g)____ uncrossed,using  

meaningful and appropriate 

cross arms,l)_______ or 

exaggerate 
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gesture 

4 _d)_________ head up and alert,h)___ leaning 

forward  

turn your  m)____ on 

someone,arm crossing,leg 

crossing 

5 e)___________ distance  not too i)___ and not too close  make listener uncomfortable 

with your   n)_____ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6b 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

i)Far 

m)Back  

k)blank 

n)proximity 

a)eye    

h) body  

d)posture  

l)overdo 

g) arms 

 

e) physical  

j) look 

b)facial  

c) gesture 

f)pleasant  
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Barriers to Effective Communication  
 

 
Apply Measures to Overcome Barriers to Communication Skills 

 
Objectives: 
Learn about  
1 Various barriers to effective communication: their types and factors 
2 Different measures that need to be adopted to overcome barriers in effective 
communication  
3 Gain practical experience of--  
 

1. Role playing barriers to effective communication and identifying 

them 

2. Practicing ways to overcome barriers in communication in a)social 

situations and b)at the workplace 

3. Counselling someone whose communication skills are hampered due 

to barriers ( enacting some situations)  

 
 

Lesson 3.1 Types of Barriers to Effective Communication 
 
Communication means sharing meaning.  With no sharing, there is no 
communication.  
 
Effective communication requires an understanding that - 

 A message is conveyed clearly between communicators in order that it is 

effective and serves the desired purpose.   

 Whether in a team or with others, at work  or  in  the  community,  the  

communication environment  is conducive and  there are no  barriers  

which  prevent  messages  being  sent  and received successfully. 

  Communication barriers create misunderstandings and 

misinterpretations of messages.  

 To communicate successfully you must know what barriers to 

communication exist and ensure that they do not obstruct 



 

 

communication.  

 You must make efforts to navigate around these roadblocks. 

A  communication  barrier  is  thus anything  that  prevents  us from  receiving  
and  understanding  the  messages  others use  to convey  their information, 
ideas and  thoughts.   
 Communication between two individuals should be simple. Remember that 
there are differences between talking and communicating.  When we 
communicate, we are successful in getting our point across to the person 
we’re talking to. When we talk, we tend to erect barriers that hinder our 
ability to communicate.  
 
Some barriers to effective communication you should be aware of are: 
 
Physical Barriers – Physical barriers separate people from each other and mark 
territories. These barriers can often be seen in the workplace where offices 
and closed doors stop communication.  
Physical barriers can stop you from being comfortable communicating with a 
person whom you do not come face to face with often. 
 As long as people still have a personal space that they can call their own, 
nearness to others aids communication because it helps us get to know one 
another. 
 

Language Barriers – Not using words another can understand will certainly 
stop your message from being conveyed. This not only applies to actual 
languages but also expressions, format used, buzz words and other jargon. 
 
 If one is not familiar with your language, misinterpretation will occur. The 
accents and dialect (use of words) of people belonging to different places differ 
even if their language is same and may become barriers to communication.  
 

For example, the abbreviation “LOL” used in chat language used to mean Lots 
of Love before, which changed to Laugh Out Loud. If a person says LOL, the 
second person can interpret the meaning in any way they want or from their 
understanding. People use both the abbreviations according to the context and 
need. 
 
Gender Barriers – Variation exists among masculine and feminine styles of 
communication. There are distinct differences between the speech patterns in 
a man and those in a woman. A woman speaks between 22,000 and 25,000 
words a day whereas a man speaks between 7,000 and 10,000. 



 

 

While women often emphasize politeness, empathy, and rapport building, 
male communication is often more direct. This means that a man talks in a 
linear, logical and compartmentalised way, features of left-brain thinking; 
whereas a woman talks more freely mixing logic and emotion, features of both 
sides of the brain. Meshing these two styles without awareness could become 
a barrier. 
 
Attitudinal Barriers - as those behaviors or perceptions that are divisive in 
nature – the ones that can lead to nagging doubt, sullen disagreement or even 
overt conflict. They all interfere with and undermine communication. These 
are barriers that distance one from others. These are visible through 
withdrawal, meaningless rituals which keep one devoid of real contact, 
superficial activities and more. 
 
Perceptual Barriers – Different world views can create misunderstanding. 
People tend to interpret messages from their own point of view or ideologies. 
Without thinking, one might only view a message from his or her own mindset 
rather than looking at it from another viewpoint.  
The problem with communicating with others is that we all see the world 
differently. 
You might ask someone an innocent question based on a previous experience 
but it is quite likely for them to perceive it with suspicion. 
 
Cultural Barriers – Ethnic, religious, and social differences can often create 
misunderstandings when trying to communicate. These differences can also 
affect one’s perception and create confusion in getting a message. 
 
Emotional Barriers –If one is consumed with emotion he will have difficulty in 
understanding what is communicated. Hostility, anger, fear, and other 
emotions make it hard to hear outside one’s own self.  
The roots of our emotional mistrust of others lie in our childhood and infancy 
when we were taught to be careful about what we said to others. We must 
have been often warned- "Mind your P's and Q's". "Don't speak until you're 
spoken to". 
As a result, many people hold back from communicating their thoughts and 
feelings to others. While some caution may be wise in certain relationships, 
excessive fear of what others might think of us can stunt our development as 
effective communicators. 
 
Overcoming these barriers to communication is no easy task. You need 



 

 

awareness and a willingness to adapt and try to form meaningful relationships. 
But, if you begin to focus on how these communication barriers are affecting 
your everyday conversation, you will be well on your way to becoming an 
effective communicator. 
 
 
Further reading : Read Dr K Usha Rani’s research paper on communication 
barriers at 
https.www.researchgate.net/publication/304038097_COMMUNICATION_BAR
RIERS 
 
 
 

Class X : Lesson 3- Communication Skills 
Worksheet 3.1 : Barriers to Communication 

 
 Blindfold Game 

 In this game break off everyone into teams of two.  

 One member is blindfolded and navigates an obstacle course. 

 The other member shouts directions to the other member. 

 
Blindfold Game works because it builds trust, listening, and instructional skills. 
Trust among team-members is crucial for effective communication. It 
encourages cooperation and successful teamwork. Lack of trust, though, 
builds suspicion and prevents buy-in. 
After playing the game discuss what went well and what did not. Identify the 
barriers that came in the way of effective communication. 
List what could have been done to improve communication. (E.g. - did you feel 
that personal or attitudinal barriers affected communication? Think of other 
barriers… gender/cultural) 
 

 
 Class X : Lesson 3- Communication Skills 

Worksheet 3.2 : Barriers to Communication 
 

 
Answer the following quiz questions- 

1. Not stating instructions clearly is an example of……….. ( language barrier) 

2. Not understanding the customs or traditions of a speaker could mean 



 

 

there is a ………………. ( cultural barrier) 

3. When you are overcome by your own feelings and unable to 

communicate well it means there is an ………………..( emotional barrier) 

4. Using slang or words that are used within your own social group is an 

example of a ………………. ( cultural barrier) 

5. You may like to have your own private cabin to work in but if you are not 

willing to meet your team face to face it is an indication of a………. 

(physical barrier) 

6. You have an…………………. ( attitudinal barrier) if you think you are more 

qualified than others and are superior in knowledge. 

7. If you have a totally different viewpoint from your team mates on the 

way a training programme is to be planned you have a 

…………..(conceptual barrier) 

 
   

 
Handling Barriers to Communication 

 
Following are some practical ideas for dealing with attitudinal barriers to 
communication so that all of your exchanges as a small business owner or part 
of a team in an office are as productive as they can be: 
Engage in face-to-face interactions whenever possible. As you've probably 
learned from experience, text messages and even emails can be 
misinterpreted without the nonverbal “assist” of facial expressions, tone and 
inflection. When timely communication is of great importance, you may have 
no choice but to send a quick text or email. In this case, be sure to follow up 
later to seek questions and to ensure that your message was understood as 
you had intended it to be.  
Reduce or eliminate distractions around you. Noise from other people and 
office machines can sink even the most pleasant interactions, dooming them to 
a rough start. They interfere with the focus you need to have so that you can 
counteract any attitudinal barriers. Then again, sometimes a lack of noise from 
other people, such as if the environment is too quiet, can be distracting; this 
could mean that people are eavesdropping on your conversation – something 
you want to avoid. If “the walls have ears,” then move your conversation to 
another part of the building or go outdoors.  
Try to assess the needs of the receiver. This is not an easy objective. But as an 
employer, look at the bright side: you're privy to some attitudinal variables: 



 

 

age, culture, education, experience, gender and race. Others, such as lifestyle 
and upbringing, may elude you. Use what you know to develop an empathetic 
stance and, if possible, tailor your message accordingly. This is another way of 
saying “know thy audience.” No doubt, you will get better with experience and 
practice.  
Hone your active listening skills. The University of Maine suggests a five-step 
approach to this alert and engaged listening style: 

a) Acknowledge the other person's ideas, thoughts or feelings. Paraphrase 

the other person's words to ensure understanding.  

b) Ask questions without judging. Summarize and clarify what you hear. 

Offer your opinion if it's requested. 

c) Organize your thoughts. You don't have to write notes, but if doing so 

helps you organize what you want to say and how you want to say it, 

then by all means, start writing. Many communications go haywire 

because the purpose is hazy in the mind of the sender. And if it's hazy in 

the mind of the sender, it might be a complete blur to the recipient. 

Soften your tone and language. As the boss, you know people watch your 
every move, so you also know that being courteous and professional is a must 
in every interaction. To defeat any attitudinal barriers, it can help immensely to 
maintain a gentle, reassuring tone and use simple, non-confrontational 
language. Keeping sentences short and direct can also help to prevent any 
misunderstandings. 
Encourage feedback. Even this seemingly benign step can be fraught with 
peril, if “the other guy” clams up and disses you behind your back. Now might 
be a good time to remember the advice about how the receiver also bears 
responsibility for whether a two-way exchange is a success or a failure. All you 
can do is ask that he understood what you had to say and if he has any 
questions you can clarify. At least, you will be doing your part as a 
conscientious communicator. 
 
 
Described below are some common barriers to effective communication which 
we must avoid:  
1  Second guessing the sender: We do this when we are impatient with the 
speaker and are in a hurry to finish the sentence for the speaker. It takes away 
from the speaker the opportunity to compete what was being said. At times, 
we could be completely off the mark while finishing off the unspoken part and 
create antagonism in the speaker. We have thus defeated out first principle of 



 

 

seeking first to understand.  
2 Stereotyping: We often form stereotypes about those whom we know the 
least! Once our mental sets are created, all our transactions are affected by 
these sets, preventing us from effective listening.  
 
3 Halo effect: This is another form of stereotyping. Based on a single 
characteristic we make up our mind usually positively about the other person. 
We may like someone's mannerisms or passion while speaking and get so 
impressed that are unable to see any negatives in this person.  
 
4 Not listening as a status or gender issue: Studies have shown that men listen 
much less than women do. Similarly those in positions listen less to those who 
are lower in hierarchy. How well do we listen to our children, or our 
subordinates? If a woman employee is speaking, are men colleagues as 
attentive as they would be when a male colleague speaks up?  
 
In addition there are others which we are familiar with such as-daydreaming, 
private planning or detouring, fatigue and exhaustion. Typical mannerisms like 
saying 'you know', 'well', or making gesticulations while talking also act as 
barriers. These can be observed in both the sender and the receiver. One can 
overcome these through seeking feedback on one's style of communication.  
 

Worksheet 3 : Barriers to Communication 
 

Read the following situations and discuss in your groups what steps can be 
taken to overcome the barriers you notice. Enact the same in front of the class. 
 
1 You are a manager in a bank. Lately, you have observed that the employees 
are not comfortable talking to you. It seems that they do not understand 
instructions given via email.  
An email sent to all the employees regarding customer dealing was 
misunderstood and they were offended.  What will you do? 
 
Step taken as a positive measure: 
 
You (as manager) decide to step out of your cabin and have a quick discussion 
with your colleagues to give them some important instructions instead of 
depending upon emails. Clarify what you wanted to convey through the email. 
 
2 Female employees of an insurance company are feeling quite frustrated. 



 

 

Their boss who is a male does not listen to them and does not give importance 
to their suggestions. Without meaning to hurt them he is quite pompous and 
wants to do things his way. 
 
What would you like to suggest to him? 
 
3 You work in a multinational company. Some of your colleagues from Sweden 
and China are coming for a conference to Delhi. You are in charge of receiving 
them.  
What steps would you take to - 

 receive them  

 make their stay in India comfortable  

 ensure they do not have problems with food 

 ensure they have no language problems 

 
 

 
 

Worksheet 4 :Handling  Misunderstanding 
 

Play this game in pairs: 
 
This game entails two persons who must sit back to back. The first person has 
an object and must describe it (without explicitly saying what the object is) to 
person B. Person B must then draw it based on the person A’s descriptions. 
 
 Causes of Miscommunication and Misunderstanding 
 
After you play the game try to fix things. 
The first step in fixing miscommunication is understanding where things go 
wrong. 
 
Understand misunderstanding 
 
The game Misunderstanding helps drive creative communication. Finding 
creative ways to communicate despite barriers builds problem-solving skills. 
No communication works exactly the same and creativity is required to make 
sure effective communication happens each time. 
 



 

 

This game can be adapted for larger groups by working in teams of two. It can 
then become a competition based on who has the most accurate drawing. 
 

 
 



 

 

Apply principles of communication 
 
 
Objectives 
 
In this lesson you will -----  
 
1. Know about the principles of effective communication 
2. Identify the 7 Cs of effective communication 
3. Apply knowledge of effective communication skills in real life situations 
 
 
 

Lesson 4.1: Principles of Communication 
 
We all wish to communicate our ideas and thoughts effectively. There are 
some principles that must be followed for communication to be successful.  
 
A Seek first to understand, then diagnose and prescribe: 
 
 The most important principle of communication is that we should understand 
the other person with our mind, heart and soul, deeply, without judging, 
without censoring.  
Stephen Covey in his book titled '7 Habits of Highly Effective People' gives an 
example of a father who complains that he is unable to understand his son as 
the son doesn't listen to him. After repeating, "I don't understand my son, he 
just doesn't listen to me", several times, the man realizes that in order to 
understand another person, one must deeply listen and only with the intention 
of truly wanting to understand.  
Very often we struggle to make ourselves understood. But if the person does 
not open up to the experience of wanting to understand the struggle continues 
and communication fails.  
  
Covey says seeking first to understand is like opening an emotional bank 
account. If you invest yourself emotionally and fully, you will get high returns 
in the form of a rewarding communication experience. When you truly 
understand the other person you can begin to explore for causes of problems 
and solutions.  
 
B Face to Face Communication is most effective:  



 

 

 
One of the requirements within any organization is to put everything down on 
paper, in writing. While all of us follow this dictum, how many of us have 
chosen to precede or follow up our written communication with a personal 
discussion or meeting? A face to face discussion can give us much better 
results. In a face to face interaction, we are able to observe and respond to 
verbal and non-verbal cues, the inconsistence between the two, offer 
feedback and seek clarifications. Some of this is not possible for example, 
when we are engaged in a telephonic conversation.  
 
C Communication becomes complex as the number of people we are 
communicating with increases: In an interaction involving only two people, 
the number of communicative stimuli, both verbal and non-verbal, is limited. 
One is left to deal with and manage the partner's interactions and structure 
one's response based on the cues received from the partner.  
But as the number of people increases, stimuli, feedback, channels also 
increase and communication becomes complex. Suppose you are talking to a 
group of 5 persons. Four of them are listening intently to you while the fifth 
one seems bored and uninterested. If you continue, you have lost the 
opportunity to understand the reason for his or her disinterest and modify 
your delivery. However, if you single this person out, she might feel cornered 
while others may become impatient.  
Thus in a group context, one has to manage several different aspects of 
communication in order to be effective.  
 
D Communication across cultures differs: Culture can be defined as shared 
knowledge, symbols, conventions, folklore, language, habits, rituals, rules and 
lifestyles that link and give a common identity to a particular group of people 
at a given point in time. Cultural differences must be respected and kept in 
mind while communicating. It is a good idea to find out about the culture, 
traditions and customs of another country or state you are visiting for the first 
time. Also remember, in a large country like India people belonging to different 
states, tribes or communities have certain mannerisms and behavioural 
characteristics that need to be understood. Not giving eye-contact to a 
member of the opposite sex or a person who belongs to a higher caste class is 
common among Indians. To a Westerner, the same gesture may mean lack of 
earnestness of the people we are interacting with.  
 
E Feedback is the key to effective communication: Communication 
transactions continue to evolve effectively in the presence of feedback. Try 



 

 

talking to a person with a deadpan face. Chances are, very soon the 
enthusiasm with which you started will wane. Conversely if the audience 
responds with nods, smiles, anything that conveys attention and interest, the 
speaker is encouraged to continue. Feedback also gives you an indication if 
there is any change needed in the communication stimuli.  Adapted from 
IGNOU  
 
 
 

 

 
Worksheet 1: Principles of effective communication 

 
1. Name the 5 principles of effective communication. Which do you find 

most important? Number them in order of importance you would like to 

give them. Say why. 

2. Do role plays in groups of 4 to show the importance of each principle. 

Enact each in 2 ways- one showing effective communication because the 

principle is followed and the other showing poor communication. Let 

other judge and say how you could have done better.  

3. You are Nazia, Group Leader, Marketing, ABC Consultants. You are very 

upset.  Shaheen, your junior has made a mess of the assigned task of 

inviting the chief guest for the inaugural ceremony of the new office 

block. 

Analyze where you may have gone wrong in communicating the 

assigned task. Find out from your junior, Shaheen what went wrong and 

why it went wrong. Sit together and seek to clarify expectations. 

Remember that you should have followed the principles of - 

understanding, then prescribing; face to face contact, and understanding 

cultural differences.  

 

 
  
     

 
Lesson 4.2: The 7 Cs of Communication 

 



 

 

Warm up- 
Try to guess what the 7 Cs of communication must be. C for clarity… C for 
courtesy…  As you may have guessed, to be effective communication must be 
clear and courteous. It must also have other qualities. Can you name some 
other qualities? 
Watch this video (in the link given below) before you read about the 7 Cs. 
 
https://youtu.be/sYBw9-8eCuMCs 
 

The 7 Cs of Communication 
 
In your daily life and at work you write emails, facilitate meetings, participate 
in conference calls, create reports, devise presentations, debate with your 
colleagues… the list goes on. 
 
We all spend almost our entire day communicating. So, it stands to reason that 
communicating clearly and effectively is very important and can boost our 
productivity. 
 
This is why the 7 Cs of Communication are stressed in our discussions on good 
communication. The 7 Cs provide a checklist for making sure that your 
meetings, emails, conference calls  , reports  , and presentations   are well 
constructed and clear – so your audience gets your message. 

Following are the 7 Cs of effective communication: 
 

 Watch this video that makes it easy to understand the 7 Cs: 
 
https//youtu.be/sYBw9-8eCuMs://youtu.be/sYBw9-8eCuM   
 
1. Be Clear 
 
Begin every message by asking the question, “What is the purpose of this 
communication?” This will enable you to make the objective of your 
communication clear to the recipient. 
Clarity is also about avoiding the use of complex words, sentences, and fuzzy 
language. 
It is important that you clearly communicate the intended information to the 
recipient. You must be able to explain a concept several ways and answer 
clarifying questions about the topic. 
 If you are not clear about the purpose of your communication, then your 



 

 

objectives will not be met. 
 
Writing points on note cards or a notepad can help you methodically work 
through what you want to communicate.  Most people will tend to drift or 
forget items if they don’t have a clear framework to operate within.  
Presentation slides can be helpful though very often a simple outline will be 
enough. 
 
1. Be concise 
 Make your message brief and to the point. Why use 10 sentences to explain 
something when a single sentence will suffice? Being concise will save time for 
both you and the receiver of your message. 
To help make your communications more concise, avoid going over the same 
point several times, and avoid the use of filler words, sentences, and over 
wordy expressions. Although we are trying to be concise, it is important to 
remember that we are not trying to lose completeness. 
3. Be Concrete 
Concrete communication is about being specific and clear rather than vague, 
obscure, and general. To be more concrete use sentences that cannot be 
misinterpreted. Include supporting facts and figures to underscore your 
message, but don’t allow anything that detracts from the focus of your 
message. 
4. Be Correct 
Incorrect information doesn’t help anyone and it does your credibility no good. 
Ensure that: Your message is typo-free; your facts and figures are correct and 
you are using the right level of language. Being correct first time will both save 
you time and boost your credibility. A correct message will also have a greater 
impact on the recipient than an incorrect one. 
5. Be Coherent 
Does your message make sense? Does it flow logically from one sentence to 
the next? To ensure that your communication is coherent: Check that each 
sentence flows logically from one to the next and check that you haven’t tried 
to cover too many points or been distracted by side issues. 
6. Be Complete 
Your message must contain all the necessary information to achieve the 
desired response. To ensure that your message is complete think about 
questions the receiver might think of as they receive your message. Address 
these questions. Ensure you have included a call to action so that your 
audience knows exactly what you expect them to do next. 
7. Be Courteous 



 

 

Be polite. You’re more likely to get what you want from your communication if 
you are courteous, as courtesy builds goodwill. Check that your message is 
polite, shows respect for the feelings of the receiver, and is tactful. Make your 
message brief and to the point. 
 
 

    
The following table makes the 7Cs clear to you- 
 

 

Sources: https://www.mindtools.com/pages/article/newCS_85.htm;                     

https://expertprogrammanagement.com/2018/04/7-cs-communication/ 

 

 



 

 

Class X - Communication Skills 

Lesson 4 : Worksheet 1-Principles of Communication 

Complete the following table with the appropriate adjectives to 

 be kept in mind while communicating with people.  

 

Answers  

  Clear- no confusion,  statement of requirement is direct, not ambiguous 

or vague 

  Concise- brief, to the point, gives only relevant information, no extra 

info 

 Correct- facts only are stated , no confusion or incorrect statement, very 

precise 

 Courteous- 

 Considerate- 

 Complete- 

 Coherent- 

Clear 

•  message easily understood 

 

concise 

 

 

correct 

courteous 

considerate 

Complete 

 

 

coherent 



 

 

 

 

 

Lesson 4- Worksheet 2 : Practice the 7 Cs 

Watch the following video and then do the activity in pairs. This activity will 

help you to practice the 7 Cs. You will also understand the need for applying 

the 7 Cs to your communication in daily life. 

Prahttps://www.youtube.com/watch?v=8yGhNwDMT-gctising the 7 Cs 

Practice communicating the following instructions or requests by writing 

sentences keeping in mind the 7 Cs. 

1. You have to give instructions to your assistant about the task of 

completing a project report by tomorrow. Write the instructions in 

language that is clear, courteous and complete.    

2. Make a written request to your colleagues who are not reaching office in 

time to sign in by 9.30 am daily. You are Kritika, Head, Department of IT, 

NIOS. ( clarity, conciseness, courtesy, correctness coherence and 

completeness) 
3. Share a plan for an important office meeting with heads of different 

departments and your colleagues. Remember to share details of the 

meeting such as: purpose, people who have been invited, venue and 

timings, agenda, sequence in which they will be discussed and other 

arrangements such as seating, tea and refreshments. You are Rashi 

Singh, Head, Human Resource, Alexis Ltd. ( clarity, conciseness, 

concreteness, courtesy, correctness coherence and completeness) 

4. Have a telephone conversation with a client. The topic is a business visit 

the client wishes to make to your company to know about the goods you 

manufacture for gifting during Diwali. ( correct, clear. coherent, concise, 



 

 

courteous and complete) 

5. Imagine you are the receiver for each of the above messages. Do you 

think the messages were complete? What changes could be made in 

them? 

6. Share the above tasks and observations orally with the whole class and 

critique for improvement where required. 

 

 

Lesson 4 : Worksheet 3 Principles of Communication 

Do the following role plays in pairs. (The first is done for you as a sample)- 

 Anita: Ma’am, could you please tell me what is to be written in the emails to 

be sent for the meeting? 

Suvarna: Yes. Please note all that I am saying. Remember to - 

a) Address each participant by name … write ‘Dear Lalita’             

b) Your invitation should be courteous and formal… write … ‘It would give 

me great pleasure…….’etc. 

c) Do not forget to write the date, timings and venue of the meeting ( 

mention the conference room and floor too) 

d) State the agenda 

e) Inform participants about arrangements for parking, who will receive 

them at the reception counter and details of the contact person for any 

queries. 

f) Lastly, do share the draft with me. 

Anita: Thanks a lot ma’am.  

Suvarna: You’re welcome, Anita. I’m sure you’ll do a great job. 

1 As product manager you have you the job of explaining to your team how to 



 

 

pack the mobile phones that are to be sent via Amazon to customers. Give 

clear, concise and complete instructions. Do not forget to be courteous. 

2 You are a receptionist in a reputed school of Kanpur. You receive a phone 

call. The caller is making a query about admission dates, sale of forms, fee 

structure, seats for economically weak students etc. 

Write the dialogue between the caller and yourself. 

Write the dialogue. Remember to express yourself in a manner that shows 

respect to the person who you are talking to. 

After writing the dialogue check it for 7 Cs. Have you taken care of them? 

Now enact the telephone conversation. 

 

 

https://mail.google.com/mail/u/0/?tab=rm#search/HEEMAL+HANDOO?projector=1 

https://mail.google.com/mail/u/0/?tab=rm#search/HEEMAL+HANDOO?projector=1 



 

 

 

Introduction to word processor 

 

A word processor is a software that helps you type and work with text on a 

computer. You can create a document like, letter, memo, newsletter and save it in 

word processor. The main advantage of creating a document is word processor is 

that a document can always be opened and edited. You can also format it, check 

and correct spellings and grammatical errors in it, insert drawings, images, and 

pictures, apply page borders, and also print it. 

 

A variety of word processors such as Microsoft Word, Open Office Writer, and 

Star Office have been developed to make text input and editing on the computer 

easy. An online word-processing applications such as Google Docs (part of Google 

Drive), is also becoming popular. 

 

In this chapter, you will learn about Apache Open Office Writer, a popular 

 Open source word processor.  

 

 

 

Apache OpenOffice  

 

Apache OpenOffice is a free and open-source software that has been developed by 

the Apache Software Foundation. Apache OpenOffice can be downloaded for free 

from:  

 

http://www.openoffice.org/  

 

It is available in a number of languages. It can also read/write files created in other 

Office software packages.  

 

The Apache OpenOffice package contains the following: 

• OpenOffice Writer (Word processor) 

• OpenOffice Calc (Spreadsheet) 

• OpenOffice Impress (Presentation) 

• OpenOffice Base (Database Management System) 

• OpenOffice Draw (Graphics) 

• OpenOffice Math (Equation Editor) 

 



 

 

The latest version of Apache OpenOffice is 4.1.5 The new version of Apache 

OpenOffice shows a sidebar on the interface of Writer, Impress, and Calc. It is 

similar to the ribbon in Microsoft Office .  

 

 

APACHE OPENOFFICE WRITER 

Apache OpenOffice Writer is a word processor program, which is equivalent to 

MS Word. It is used for creating, editing, formatting, and printing text documents. 

You can include pictures, charts, tables, and can save the document in various 

formats.  

To start OpenOffice Writer, click Start  All Programs  OpenOffice 4.1.5  

OpenOffice Writer. 

The Apache OpenOffice Writer window, along with its sidebar and other 

components, is shown in Figure 1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 1 Apache OpenOffice Writer window 

 

Title Bar  The title bar is placed at the top of the Word 2013 window. It displays 

the document name followed by the program name. To the right of the title bar, 

you can see three buttons: Minimize, Restore Down/Maximize and Close. 

Title bar 
Standard bar 

Formatting 

bar 

Vertical 

ruler 

Status bar 

Zoom control 

Minimize 
Maximize/Re

store Down 

Close 

Side bar 



 

 

The Minimize button is used to reduce the window to a small icon on the taskbar. 

The Restore Down button is used to make the window smaller than full size. The 

same button is used to bring it back to full size. The Close button is used to close 

the window. 

 

 

Menu bar The Menu bar has different options like, File, Edit, View, etc. clicking 

on a menu option displays options of this menu. 

 

 

Standard Toolbar It is displayed below the Menu bar and contains buttons for the 

most commonly used commands, like, New, Open, Save, etc. 

 

 

Formatting toolbar This toolbar has buttons for the most commonly used 

formatting commands. 

 

 

Document Window The document window is used to create a document. This is 

the area where you can type text, insert pictures, etc. 

 

 

Scroll bars  The horizontal scroll bar is present at the bottom of the document 

window and is used to move the document left or right. The vertical scroll bar is 

present to the right of the document window and is used to move the document up 

and down. 

 

 

Rulers The horizontal ruler is present at the top of the document window and is 

sued to set left and right margins. The vertical ruler is present to the right of the 

document window and is used to set top and bottom margins. 

 

 

Status bar The Status bar is present at the bottom of the Writer window. It 

displays information about the current document, such as number of pages, current 

page number, etc. 

 

Zoom control The zoom level of the document can be set by clicking, holding, 

and dragging the slider. 

 



 

 

Let’s Try it 

 

 

1. Start OpenOffice Writer. 

2. Identify the following components of the OpenOffice Writer window: 

i. Title bar 

ii. Standard bar 

iii. Formatting bar 

iv. Horizontal and vertical scroll bar 

v. Horizontal and vertical ruler 

vi. Minimize, maximize and Close buttons 

vii. Status bar 

 

 

 

 

Creating a New Document 

To create a new text document in OpenOffice Writer: 

1.  Select File  New  Text Document. (Fig 2) 

 

 
 

Fig 2   New option of File menu 

 

 

Or 

 

Click New button on the Standard toolbar (Fig 3) and select the desired option the 

menu to create a new text document. 



 

 

 

 

 

 

 

 

 

Fig 3 New button on the Standard toolbar 

 

Or 

 

You can also press Ctrl + N on the keyboard to create a new document. 

 

Saving a Document 

To save a document,  

1. Click the File menu 

2. Select Save As option . (Fig 4  ) 

 

 

 
 

Fig 4 Save AS option of File menu 

 

Or 

New Button 



 

 

 

Click the Save button on the Standard bar as shown in Figure 5. 

 

 

 

 

 

 

 

Fig 5  Save button on the Standard toolbar 

 

3. The Save As dialog box appears. (Fig  6) 

4. Select the location where you want to save the document. 

5. Type the file name, and click on the Save button. Documents created and 

saved in Writer have the extension .odt by default. 

 

 

 
 

Fig  6 Save As dialog box 

 

 

 

 

 

 

Save button 

Keyboard Shortcut 

Save   Ctrl +S 

Save As  Shift + Ctrl + S 



 

 

 

Saving a file in different format 

If you want to save a file in a different format other than the default format .odt of 

OpenOffice Writer. The Steps are: 

1. Select Save As option of File menu. 

2. The Save As dialog box appears.(Fig 6a) 

a. Select the File type from the Save as type drop-down list. 

b. Type the filename. 

c. Click Save button. 

 
 

 

 

 

Fig 6a  Save As dialog box 

 

 

 

Opening a Document 

To open an already saved document in OpenOffice Writer: 

 

1. Click the Open option from the File menu. 

Or 



 

 

Click the Open (Fig 7) button on the Standard bar. 

 

 

 

 

 

 

Fig 7 Open button on the Standard bar 

 

Or 

 

Press Ctrl + O. 

2. The Open dialog box appears (Fig 8). 

3. Select the Drive and the folder. 

4. Select the file and click Open button. 

 

 

 
 

Fig 8 Open dialog box 

 

Closing a Document 

To close an open document, click the Close option from the File menu. 

 

Exit Writer 

To exit Writer, click the Exit option from the File menu. 

Open button 



 

 

Let’s Try it 1 

 

1. Start OpenOffice Write. 

2. Create a new document. 

3. Type a paragraph about some of the activities organized in your school. 

4. Save the document with name ‘activities’. 

5. Close OpenOffice Writer. 

 

Let’s Try it 2 

 

1. Start OpenOffice Writer. 

2. Open the already saved document ‘activities’. 

3. Now add another paragraph about various competitions that your school is 

planning to organize on ‘Independence Day’. 

4. Save the document. Which option will you select to save the file with the 

same name –Save or Save As? 

5. Close the document. 

6. Exit from Writer. 

 

Worksheet 1 

 

1. Name the two toolbars.  ____________  ________________  

2. Name the toolbar used to scroll the document up and down ________  

3. Name the bar present at the bottom of the Writer window that gives 

information about the number of pages in the document. __________  

4. Name the two rulers ____________  ______________  

5. Name the ruler that is used to set the left and right margins __________  

6. Name the bar that has buttons for the most commonly used commands 

______   

7. Name the three buttons present to the right of the Title bar. ______  

8. Name the button used to reduce the window to a small icon on the taskbar. 

_____________  

9. Which button is sued to make the window smaller than full size? 

___________  

10.  Mention any two features of word processors. 

___________________________  

___________________________ 

 

 

 



 

 

Worksheet 2 

 

 

1. Write Keyboard shortcuts for the following commands: 

i. New 

ii. Save 

2. Name the menu that has option to create a new document. 

3. What is the difference between Save and Save As options of File menu? 

 

EDITING A DOCUMENT 

Editing means making changes into existing text.  

Before editing, you may need to select the text. Selection of text can be done with 

the keyboard or the mouse. 

The selected text gets highlighted with blue color. 

OpenOffice Writer features various tools to edit text in a document.  

 

 

Selecting Text Using a Mouse 

To select text using a mouse, follow the steps: 

1. Place the cursor to the left of the first character of the text to be selected. 

2. Press the left mouse button and drag the mouse to the position where you want 

to end selection. 

3. Release the mouse button. The selected text gets highlighted in grey (Fig. 9). 

 

 

 
 

Fig 9 Selecting text 



 

 

 

 

Selecting Text Using Keyboard 

You can select text using even the keys on your keyboard. First, place the cursor to 

the left of the first character you wish to select. Then use the following key 

combinations: 

To select      Key combinations 

One character to the left     Shift + 

One character to the right    Shift +  

One line up       Shift + 

One line down      Shift + 

To the end of the current line    Shift + End 

To the beginning of the current line   Shift + Home 

To the end of the current document   Shift + Ctrl + End 

To the beginning of the document   Shift + Ctrl + Home 

Entire document      Ctrl + A 

 

Inserting and Overtyping Text 

You can insert (add) text into the existing text or overtype (replace old text with 

the new one) text in OpenOffice Writer.  

To insert text, press the Insert key, to turn ON the Insert mode, which is indicated 

by INSRT appearing on the status bar (Fig. 10). 

 

 

 

 

 

 

 

 

 

Fig. 10 INSRT on the status bar 

 

Sometimes, you may need to type and replace the current text. This can be done 

using the Overtype mode. To overtype text, press the Insert key or click on 

INSRT on the status bar to turn ON the Overtype mode, which is indicated by 

OVER appearing on the status bar (Fig. 11) 

 

 

 

INSERT mode selected 

on the Status bar 

OVER mode selected on the 

Status bar 



 

 

 

 

 

 

 

 

 

Fig. 11 OVER on the status bar 

 

 

 

 

 

 

Inserting a Blank Line 

You can also insert a blank line between two existing lines. The steps are: 

 

1. Place the cursor at the end of the line after which you want to insert a blank line. 

2. Press Enter. You will notice that the next line gets shifted down and a blank line 

is inserted. 

 

 

Deleting Text 

You can easily delete a character, a word, or a block of text in OpenOffice Writer. 

Let us learn how to delete a character, a block of text or a word. 

 

To delete a character, the steps are: 

1. Position the cursor to the left of the character to be deleted. 

2. Press DELETE. 

Or 

1. Position the cursor to the right of the character to be deleted. 

2. Press BACKSPACE. 

 

To delete a block of text, the steps are: 

1. Select the text to be deleted. 

2. Press DELETE or BACKSPACE. 

 

To delete a word, the steps are: 

1. Place the cursor to the left of the word to be deleted. 

2. Press Ctrl + Delete. 



 

 

Or 

1. Place the cursor to the right of the word to be deleted. 

2. Press Ctrl + Backspace. 

 

Undo and Redo Commands 

The Undo command is sued to reverse the last command/action. 

To reverse the last action, click the Edit button and then click Undo in the drop-

down menu.(Fig 12) 

Or 

Click the Undo  button on the Standard bar. (Fig 13) 

 

 

 

 

Fig 12 Undo option of Edit menu. 

 

 

 

 

 

 

 

 

 

Fig 13 Undo button on the Standard toolbar 

Undo  

Undo button Redo button 



 

 

 

 

The Redo command is used to reverse the last Undo action. To apply this 

command, click the Redo option from the Edit menu. 

Or 

Click the Redo  button on the Standard bar.(Fig 13) 

 

Note: As long as there is nothing to redo, the Redo command will 

show up as Repeat command. The function of the Repeat 

command is to repeat the last thing you did in OpenOffice Writer. When you 

undo an action, the Repeat command changes to Redo. 

 

 

 

 

 

 

 

 

Copying Text 

You can easily copy text from one place to another in a document. For this 

purpose, you will have to use Copy and Paste commands. The Copy command 

creates a duplicate of the selected text and the Paste command pastes the copied 

text at the position where the cursor is placed. 

 

To copy text from one location and paste it at another location, the steps are: 

1. Select the text to be copied. 

2. Click the Copy option from the Edit menu. (Fig 12) 

Or 

Click the Copy  button on the Standard bar. (Fig 14) 

3. Position the cursor at the location where you want to paste the text. 

4. Click Paste option from the  Edit menu. 

Or 

Click the Paste button on the Standard bar. (Fig 14) 
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Fig 14 Standard bar 

 

Moving text 

You can easily move text from one position to another using Cut and Paste 

commands. The steps to move text from one location to another are: 

 

1. Select the text to be moved. 

2. Click the Cut option from the Edit menu. (Fig 15) 

Or 

Click the Cut  button on the Standard bar. (Fig 14) 

3. Position the cursor at the location where you want to paste the text. 

4. Click Paste option in the Edit menu or Paste button on the Standard bar. 

 

 

 
 

Fig 15 Edit menu 

 

FORMATTING A DOC UMENT 

Keyboard Shortcut 

Copy  Ctrl + C 

Cut  Ctrl + X 

Paste  Ctrl + V 



 

 

Formatting is the process of changing the appearance of the text in a document 

through the use of various fonts, font colors, font sizes, etc. 

 

Settings that are standard or pre-defined in a software are called default settings. 

Formatting helps the user to make changes in the default settings.  

 

Character Formatting 

Character formatting can be done either by using the Format menu or by using the 

Formatting toolbar. 

Character Formatting Using the Format Menu 

1. Select the text. 

2. Click the Format menu bar and then select Character option (Fig. 15). The 

Character dialog box appears. (Fig 16) 

 You can change the font, font size, and typeface using the Font tab in 

the dialog box (Fig. 16). 

 Click on the Font Effects tab to change the font color, font effect, and apply 

other styles such as underlining (Fig. 17). 

 

 
 

Fig. 15  Character option of the Format menu 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 16 Font tab of the Character dialog box 

 

 

Select Font Select Typeface Select Font size 



 

 

 
 

 

 

Fig. 17 Font Effects tab of the Character dialog box 

 

 

 You can change the position of the text (e.g., superscript, subscript, etc.) 

using the Position tab (Fig. 18). 

 



 

 

 
 

Fig. 18 Position tab of the Character dialog box 

 

3. Click OK after choosing the desired options. 

 

 

 

Character Formatting Using the Formatting Bar 

The Formatting bar has various buttons on it, as shown in Figure 19. These 

buttons can be used for character formatting. 

 

 

 

 

 

 

 

Fig. 19 Formatting bar 

 

 

Keyboard Shortcuts 
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You can also use the Properties side bar to format the text (Fig 21) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 21 Properties Side bar 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 21  Properties bar 

 

Highlighting Text 

 

Highlighting means making the text look different to draw the reader’s attention 

towards it. Highlighted text has a colored background. 

The steps to highlight text are: 

1. Select the text. 

2. Click the drop-down arrow of the Highlighting button on the Formatting 

bar.(Fig 22) 
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OR 

 

You can click the drop-down arrow of Highlighting button on the Properties side 

bar (Fig 23). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 22   Highlighting button on Formatting bar 
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